GRADUATE COUNCIL: NEW COURSE PROPOSAL

Originating Unit: Environmental and Sustainability Sciences

Type of action: |[] [ New course Full online course**

Semester and year course will take effect: Fg|| 2023

New course title: \Water Resources Research

Appropriate computer abbreviation (30 spaces or less): \Water Resources Research
Course instructional methodology: Directed Studies

course component types: ugradcouncil.tcu.edu/forms/Course Component Types.pdf

New course number: 70040

Prerequisites for new course: include an attachment if additional space is needed

In graduate program at TCU

attached files can be seen and managed in Acrobat Pro by clicking on

Click here to attach a file
View > Show/Hide > Navigations Panes > Attachments




Description of new course (catalog copy): include an attachment if additional space is needed

Field, laboratory, and computational modeling problems in water resources for graduate students. Fifty clock hours of laboratory,
computational, and fieldwork for each semester hour credit. 1-6 semester hours.

attached files can be seen and managed in Acrobat Pro by clicking on

Click here to attach a file ) ) S
View > Show/Hide > Navigations Panes > Attachments




Fully Online Courses**

All online courses, and /or distance learning offerings must meet State Compliance regulations as defined by specific state
legislation. TCU Distance Learning is any for-credit instruction provided to a TCU student outside the State of Texas.
This includes internships, clinical, video conferencing, online, or any other delivery format that crosses state lines.
Contact the Koehler Center for Teaching Excellence for guidelines. Include a letter of support from the Koehler Center
with this proposal.

Supporting evidence or justification: (For a new course, attach proposed syllabus, including course objectives,
course outline, and representative bibliography.)

Describe the intended outcomes of the course and how they will be assessed: include an attachment if
additional space is needed

Assessment for this course involves three components 1) participation (in fieldwork, data analysis, and
lab meetings), and 2) the production of either an oral or poster presentation of the research conducted
or a written account of the research. The latter can include a manuscript or report, but expectations for
the written account will be outlined to the student prior to and again at the beginning of semester and
be contingent on the number of credit hours taken. For instance, a manuscript-style write-up may only
be expected if the student is taking 3 credit hours of directed study.

attached files can be seen and managed in Acrobat Pro by clicking on
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Additional resources required:

Faculty: None
Space: None
Equipment: None
Library: None
Financial Aid: None
Other: None

Change in teaching load: No

Does this change affect any other units of the University? Yes || No

If yes, submit supporting statement signed by chair of affected unit.

If cross-listed, provide evidence of approval by all curriculum committees appropriate to both the originating and
the cross-listed units.



Chair of Originating Unit:

Name: Michael Slattery

Unit:  Environmental and Sustainability Sciences

. . Digitally signed by Michael Slatt
semsor: Michael Slattery S ierss Sutey



ENSC 70040 — Water Resources Research Fall 2023

Semester: Fall 2023 Instructor: Gehendra Kharel, PhD, Asst. Professor
c Time: TBD Office Hours: TBD or by appointment
T U Location: SWR 219 Office: SWR 219 | Office Phone: (817) 257-5318
Class Nbr: ??? | Section: ??? Email: g.kharel@tcu.edu | Response Time: within 24 hrs

COURSE CATALOG DESCRIPTION: Field, laboratory, and computational modeling problems in water resources management for
graduate students. Fifty clock hours of laboratory, computational, and fieldwork for each semester hour credit. 1-6 semester hours.

LEARNING OBJECTIVES AND OUTCOMES: In this course, graduate students gain research experience in environmental and
sustainability science. The course content focuses on developing and implementing effective research methods. In consultation with
the instructor, students develop a plan for collecting, measuring, and analyzing data to address research goals. Students collect and
analyze data to answer questions that provide information related to water resources and their management. The primary
deliverable for the course is a professional research poster or an oral presentation.

After completing this course, students should be able to:
1. Identify and implement key elements of research design.
2. Collect and process data using appropriate sampling techniques and procedures.
3. Analyze data using appropriate methods and tools, including statistical analyses, GIS and Remote Sensing operations, or
qualitative techniques.
4. Evaluate results with supported scientific evidence; and
5. Communicate research results through a poster/oral presentation or a report.

READING: The instructor assigns readings based on the research topic and selected methods of analysis. Readings will be shared
with students via TCU online and may include journal articles, book chapters, government reports, and popular press coverage of
current events related to the research topic.

COURSE MEETINGS AND INSTRUCTIONAL METHODS: Students and the instructor will meet weekly at a mutually agreed upon time
and day. Students will develop and conduct their research, analyze data, and prepare presentations at times suitable for their
selected research project. In consultation with the instructor, students will develop a schedule for the semester.

MAPPING OF COURSE OUTCOMES, COURSE ACTIVITIES AND ASSIGNMENTS, AND GRADE PERCENTAGES:
Course Course Activities and Assignments Grade
Outcomes Percentage
1-5 Weekly participation includes 25%
attendance at meetings, field sites,
laboratory, or data analysis exercises.
1-5 Research poster/presentation/report 75%

GRADE CALCULATION:
Letter Score
Grade
100-90%
89.9-80%
79.9-70%

69.9% or <

MmO (W >

COURSE PARTICIPATION AND ENTHUSIASM (25 PTS.)

Students will undertake a directed research project that meets the course description and is consistent with the research objectives
of Dr. Kharel’s Water and Society Lab. Points will be assigned at the instructor’s discretion and based on a rubric posted to TCU
Online.

Students are expected to:

. Participate in undertaking a research project. The specifics detailing the project goals and commitments will be
attached to this syllabus and available on TCU Online.
. Participate in weekly research meetings.



. Complete reading assignments (e.g., books, book chapters, and scientific articles) on time and prepare for

discussion.

. Provide timely feedback on the progress of their research project during the regularly scheduled research
meetings.

. Communicate timely with Dr. Kharel if any assistance is needed to execute the project.

Students must participate in the allotted time. Note students cannot receive participation credit if they did not engage, not matter
what the reason. However, if a student contacts the instructors prior to their absence, we will work with the student to determine if
there are alternative options such as an incomplete or another project that they can work on to make up the time needed.

RESEARCH PROJECT OUTPUT (75 PTS.)
Research posters must be completed independently and uploaded to TCU Online on their respective due dates.

The elements described below outline essential sections of a professional research poster/oral presentation or report. The student
will work on completing each piece over the semester under the supervision of the course instructor. All sections should be included
in the final product.

1. Introduction: The introduction clearly defines the research question(s) or objective(s) and the study’s rationale. Relevant
background information provides a context for the research and reports’ significant trends, findings, and information from reputable
sources (e.g., literature and government reports).

2. Methods: Methods include the flow and proper sequence of essential aspects of the research design. This may be represented as
a model, flowchart, or series of ordered bullet points. The methods section clearly and concisely answers the question, “what did the
researchers do?” Photographs and/or figures may be used to illustrate relevant aspects of the methods.

3. Results: Study outcomes are organized in clearly labeled tables, graphs, figures, and statistical tests appropriate to the data type.
Descriptive captions accompany all figures. Titles, legends, keys, and other descriptors contribute to the organization and clarity of
the data. Data analyses indicate proper use of formulas and statistics (if applicable) and are free from calculation errors. If relevant,
results may also include illustrations and/or photographs that aid in data interpretation.

4. Discussion and Conclusion: Major findings are clearly and concisely summarized about the original purpose of the research (i.e.,
what do the results tell you about the “big picture”?). Conclusions are logical and consistent with the data presented. Where
appropriate, authors may offer alternative interpretations of data and/or critically evaluate the effectiveness or limitations of their
methods. Suggestions for future studies are noted that expand understanding of the question tested.

5. Other logistics: The above sections (1-4) and other elements as determined appropriate, such as title page, table of contents,
abstract, and references (using a standard reference manager such as EndNote), will be combined to produce a professional
research product.

TCU IMPORTANT INFORMATION AND POLICY STATEMENTS for the 2022-2023 School Year:

Technology Policies

e  Email: Only the official TCU student email address will be used for all course notification. It is your responsibility to check your
TCU email on a regular basis.

e Course Materials: TCU students are prohibited from sharing any portion of course materials (including videos, PowerPoint
slides, assignments, or notes) with others, including on social media, without written permission by the course instructor.
Accessing, copying, transporting (to another person or location), modifying, or destroying programs, records, or data belonging
to TCU or another user without authorization, whether such data is in transit or storage, is prohibited. The full policy can be
found at: https://tcu.policytech.com/dotNet/documents/?docid=55&public=true.

Violating this policy is considered a violation of Section 3.2.15 of the Student Code of Conduct (this policy may be found in
the Student Handbook (https://deanofstudents.tcu.edu/student-handbook/), and may also constitute Academic Misconduct or
Disruptive Classroom Behavior. TCU encourages student debate and discourse; accordingly, TCU generally interprets and applies
its policies, including the policies referenced above, consistent with the values of free expression and First Amendment
principles.

Academic Misconduct



Academic Misconduct (Sec. 3.4 from the TCU Code of Student Conduct): Any act that violates the academic integrity of the

institution is considered academic misconduct. The procedures used to resolve suspected acts of academic misconduct are available
in the offices of Academic Deans and the Office of Campus Life and are also listed in detail in the Undergraduate Catalog and the
Graduate Catalog Specific examples include, but are not limited to:

Cheating: Copying from another student’s test paper, laboratory report, other report, or computer files and listings; using,
during any academic exercise, material and/or devices not authorized by the person in charge of the test; collaborating with or
seeking aid from another student during a test or laboratory without permission; knowingly using, buying, selling, stealing,
transporting, or soliciting in its entirety or in part, the contents of a test or other assignment unauthorized for release;
substituting for another student or permitting another student to substitute for oneself.

Plagiarism: The appropriation, theft, purchase or obtaining by any means another’s work, and the unacknowledged submission
or incorporation of that work as one’s own offered for credit. Appropriation includes the quoting or paraphrasing of another’s
work without giving credit therefore. Iltems will be checked as part of the TCU Online assighment submission process.
Collusion: The unauthorized collaboration with another in preparing work offered for credit.

Abuse of resource materials: Mutilating, destroying, concealing, or stealing such material.

Computer misuse: Unauthorized or illegal use of computer software or hardware through the TCU Computer Center or through
any programs, terminals, or freestanding computers owned, leased or operated by TCU or any of its academic units for the
purpose of affecting the academic standing of a student.

Fabrication and falsification: Unauthorized alteration or invention of any information or citation in an academic exercise.
Falsification involves altering information for use in any academic exercise. Fabrication involves inventing or counterfeiting
information for use in any academic exercise.

Multiple submission: The submission by the same individual of substantial portions of the same academic work (including oral
reports) for credit more than once in the same or another class without authorization.

Complicity in academic misconduct: Helping another to commit an act of academic misconduct.

Bearing false witness: Knowingly and falsely accusing another student of academic misconduct.

TCU Online: Our Learning Management System

Technical Requirements: Check your computer is ready by looking at the specifications list.
(https://community.brightspace.com/s/article/Brightspace-Platform-Requirements)
Log In: (using your TCU Network Credentials)
1. Access via my.tcu.edu > Student Quick Links > TCU Online
2. Login at the following website (http://d2l.tcu.edu) my.tcu.edu
For information about logging into TCU Online, view these instructions. (http://tcuonline.tcu.edu/kb/how-do-i-log-in/).
Student Orientation Tutorial for TCU Online: If you have not yet taken the TCU Online Student Orientation Tutorial, please do
so now. To access it, click on the Orientations semester OR view all courses in your My Courses widget visible upon logging in to
TCU Online. Click on the "Student Orientation Tutorial” to enter the orientation course. Follow the instructions in the course.
You can return to this tutorial at any time.
How This Course Will Use TCU Online: Students will access most of the course readings via TCU Online. Additionally, students
will turn in assignments through TCU Online. The instructor will post presentations and grades to TCU Online.
Getting Help with TCU Online: If you experience any technical problems while using TCU Online, please do not hesitate to
contact the D2L HELP DESK. They can be reached by phone or chat 24 hours a day, 7 days a week, 365 days a year.
e Phone: 1-877-325-7778
e Chat: Chat is available within TCU Online in the Help menu on the navigation bar.

If you are working with the helpdesk to resolve a technical issue, make sure to keep me updated on the troubleshooting
progress.

If you have a course-related issue (course content, assignment troubles, quiz difficulties) please contact me.
Personal Settings & Notifications for TCU Online: As a student, you should set up your account settings, profile, and
notifications. To do this you will login to TCU Online and select your name on the top right of the screen. You can upload a photo
of yourself and add personal information to your profile. In the notifications area, you can add your phone number to receive
text messages when grades are given, as well as reminder texts for upcoming assignments and quizzes.

Student Success Tools for TCU Online

Pulse: Pulse is a phone app which gives you access to the course calendar, assighments, grades, and announcements. This app
provides a graph that can help you manage your time. Based on the number of assighments and events on the course calendar
for your classes, the graph will display busy times for class work in the upcoming week. You can use this app to manage your
daily workload, and it includes the ability to view and access course materials offline. You can download Pulse from the Google
Play or Apple Store. You can learn more and download Pulse here: https://www.d2l.com/products/pulse/.




e ReadSpeaker: ReadSpeaker includes a number of tools that can enhance your understanding and comprehension of course
materials. ReadSpeaker can create an audio version of content that you can listen to while on a page within a course or that you
can download to listen offline. ReadSpeaker can also read Microsoft Office files and PDFs. There are additional tools and
features to assist you with reading and focusing in TCU Online, tools that provide support for writing and proofing text, and
tools that can read non-TCU Online content aloud. You can learn more about how to use ReadSpeaker tools here:
https://tcuonline.tcu.edu/how-to-hub/instructor-how-to-hub-for-tcu-online/integrations-and-mobile/readspeaker/

Support for TCU Students: Campus Offices

e Academic Advising (817-257-7486, Jarvis 104)

e  Brown-Lupton Health Center (817-257-7938 or 817-257-7940)

e  Center for Digital Expression (CDeX) (cdex@tcu.edu, Scharbauer 2003)

e  Center for Writing (817-257-7221, Reed Hall 419)

e Counseling & Mental Health Center (817-257-7863, Jarvis Hall 2nd floor)
e Dean of Students (817-257-7926, the Harrison 1600)

e  Mary Couts Burnett Library: Reference Desk (817-257-7117)

e  Office of Religious & Spiritual Life (817-257-7830, Jarvis Hall 1st floor)

e Student Access & Accommodations (817-257-6567, The Harrison 1200)
e Student Success (817-257-8345, Samuelson Hall, West Entrance)

e Substance Use and Recovery Services (817-257-7100, Jarvis Hall 2nd floor)
e Transfer Student Center (817-257-8345, Samuelson Hall, West Entrance)
e Veterans Services (817-257-5551, Jarvis Hall 2nd floor)



Anti-Discrimination and Title IX Information
Statement on TCU’s Non-Discrimination Policy

TCU is committed to providing a positive learning, living, and working environment free from unlawful discrimination,
harassment, sexual misconduct, and retaliation. In support of this commitment, in its policy on Prohibited Discrimination,
harassment, sexual misconduct and retaliation, TCU has a range of prohibited behaviors, including unlawful discrimination and
harassment and related sexual and other misconduct based on age, race, color, religion, sex, sexual orientation, gender, gender
identity, gender expression, national origin, ethnic origin, disability, predisposing genetic information, covered veteran status, and
any other basis protected by law. The Office of Institutional Equity (OIE) is responsible for responding to all reports of
discrimination, harassment, sexual misconduct and retaliation.

Please use the following links to review TCU Policy 1.008 Prohibited Discrimination, Harassment, Sexual Misconduct and
Retaliation or to review TCU Policy 1.009 Responding to Reports of Prohibited Discrimination, Harassment, Sexual Misconduct, and
Retaliation.

To make a report, you may call OIE at 817-257-8228, email oie@tcu.edu, visit us at The Harrison, Suite 1800 or click here: Make
a Report.

To learn about the Campus Community Response Team (CCRT) and Report a Bias Incident click here:
https://inclusion.tcu.edu/campus-community-response-team/

Title IX

TCU’s Title IX Coordinator works within OIE. Andrea McDew serves as TCU’s Title IX Coordinator. You may call 817-257-8228 to
make a report, email oie@tcu.edu or a.mcdew@tcu.edu, or make a report here. Additional Title IX resources and information are
available at https://www.tcu.edu/institutional-equity/title-ix/index.php.

Mandatory Reporters

All TCU employees, except confidential resources, are considered Mandatory Reporters. Mandatory reporters are required to
immediately report to OIE any conduct that raises Discrimination, Harassment, Sexual Misconduct (Title IX or Violence Against
Women (VAWA)) or Retaliation. Mandatory reporters cannot promise to refrain from forwarding the information to OIE.

Confidential On-Campus Resources

e  Campus Advocacy, Resources & Education
http://www.care.tcu.edu/ | 817-257-5225

e Counseling & Mental Health Center
www.counseling.tcu.edu | 817-257-7863

e Religious & Spiritual Life
www.faith.tcu.edu | 817-257-7830

On Campus Resources
e TCU Police
www.police.tcu.edu | 817-257-8400 Non-emergency | 817-257-7777 Emergency

TCU Policy for Religious Observations & Holidays

“Students who are unable to participate in a class, in any related assignment or in a university required activity because of the
religious observance of a holy day shall be provided with a reasonable opportunity to make up the examination or assignment,
without penalty, provided that it does not create an unreasonable burden on the University.” For more information, please visit the
TCU Policy for Religious Observations & Holidays webpage.

Student Access and Accommodation

Texas Christian University affords students with disabilities reasonable accommodations in accordance with the Americans with
Disabilities Act and Section 504 of the Rehabilitation Act. To be eligible for disability-related academic accommodations, students are
required to register with the TCU Office of Student Access and Accommodation and have their requested accommodations
evaluated. If approved for accommodations, students are required to discuss their official TCU Notification of Accommodation with
their instructors. Accommodations are not retroactive and require advance notice to implement. The Office of Student Access and
Accommodation is located in The Harrison, Suite 1200. More information on how to apply for accommodations can be found at
https://www.tcu.edu/access-accommodation/ or by calling Student Access and Accommodation at (817) 257-6567.

Audio Recording Notification



Audio recordings of class lectures may be permitted by the instructor or as an approved disability accommodation through
Student Access and Accommodation. Recordings are not to be shared with other students, posted to any online forum, or otherwise
disseminated.

Emergency Response Information

e View TCU’s L.E.S.S. is More public safety video to learn about Lockdown, Evacuate, and Seek Shelter procedures.
(https://publicsafety.tcu.edu/less-is-more/)

e View the TCU Building Safety Maps that show the specific seek shelter locations and building rally points for evacuation.
(https://publicsafety.tcu.edu/less-safety-maps/)

e View the TCU Evacuation Rally Point Map to see all rally points for evacuation. (https://publicsafety.tcu.edu/wp-
content/uploads/2020/01/TCU-Rally-Point-Map.pdf)

e Download the Frogshield Campus Safety App on your phone. (https://police.tcu.edu/frogshield/).

In the event of an emergency, call the TCU Police Department at 817-257-7777.

Student Perception of Teaching (SPOT)

Towards the end of the term you will receive an email asking you to complete your SPOT for this course. | appreciate your
thoughtful and reflective feedback to help make this course successful for future students. You can fill out the SPOT by clicking on
the link in the email or in TCU Online when SPOTs open.

TCU Mission Statement

The mission of Texas Christian University, a private comprehensive university, is to educate individuals to think and act as ethical
leaders and responsible citizens in the global community through research and creative activities, scholarship, service, and programs
of teaching and learning offered through the doctoral level.
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